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Introduction:

DilaSoft for Windows now supports data temperature correction files for 
Viscometer instruments. These files, once created, greatly enhance the 
accuracy of the instruments by correcting for differences in the materials used in 
specimen holders, push rods, etc. by correcting for temperature versus log of 
viscosity of known samples.

The temperature correction files are created by the user on their own instrument, 
guaranteeing accuracy by using the exact setup that will be running the later 
experiments. They can be recreated any time there is a change in the 
instrument, such as a specimen holder or push rod replacement. There is a 
single temperature correction file for each ramp rate used in the temperature 
program. The temperature correction file must be used with the same type of 
segment (heating or cooling) as was used to create it. For example; the 
temperature correction file was created using a 5 degree heating segment. This 
file will not be accurate with a 5 degree cooling segment!

The software will try to match a temperature correction file to every ramp rate 
used in a temperature program, segment by segment. Therefore temperature 
correction files must be created for each separate ramp rate that  will be used in 
the experiments. If a matching temperature correction file is not found during an 
experiment, no correction will be applied for that ramp rate/segment and the 
experiment will continue.



By default, the temperature correction files are placed in the preset data 
directory (set from the files-directory settings menu). The files may be left there 
or moved into the main program directory (usually "c:\tw32"). The software will 
look in both directories for the files. However the data directory does take priority 
if two temperature correction files have the same name but reside in the two 
separate directories. Moving the files into the main program directory is useful in 
cases where the data directories are cleared out or archived as this would also 
remove the temperature correction files.

Following is an explanation of how to create and use temperature correction 
files. The examples use a ramp rate of one degree per minute. Creating other 
files is done exactly the same way by substituting other ramp rates in the 
temperature program segment and associated filenames.

Creating Temperature Correction Files for Theta Viscometers
Brief Explanation.

Basic setup and procedure:

Make sure the instrument is calibrated, then set up the instrument as for a 
standard experiment.

Create a one segment temperature program at the desired ramp rate.

Set up the experiment making sure that:
"Use correction file" is off.
"Use temperature correction file" is off.
The specimen material is known.
Specimen load, height, volume, diameter and minimum height are correct.
Name the data file according to the ramp rate.

Start the experiment and let it run to the end.

Creating Temperature Correction Files for Theta Viscometers
Detailed setup and procedure:

Set up the instrument:



Make sure that the instrument is set up correctly before starting the experiment 
as the accuracy of the temperature correction file depends entirely on the quality 
of the instrument setup. Careful attention must be given to specimen/reference 
and thermocouple positioning. Also check push rod alignment and pressure 
against the specimen/reference materials. The instrument must be accurately 
calibrated.

Create a one segment temperature program for the desired ramp rate: ( sample 
temperature programs are supplied with new installations titled: ramp01.set, 
ramp02.set, etc.)

Select the correct ramp rate for the temperature correction file: here we are 
using one degree per minute.
Enter the Program tab of the main menu and select Change.
Select New at the top of the page.
Click on the first line of the blank temperature program and enter the data as 
follows:

Ramp at 1 degree per minute to 1000 degrees; hold for 10 minutes; storage 
interval of 5 seconds; log data.

The ramp rate must coincide with the data filename for the temperature 
correction file. Here we are setting up a temperature correction file for a one 



degree ramp. The data file name must be "ramp01.prn" and the ramp rate must 
be set at "1". The temperature target will depend on the furnace, specimen 
holder, push rods, thermocouples and specimen/reference material. It should be 
set higher than the normal target temperatures to be run in standard 
experiments, but can not exceed the maximum temperature of the instrument. It 
is not recommended that the specimen under test be completely melted as this 
may damage the instrument.

The hold time is set to 10 minutes to allow the specimen to catch up to the 
furnace temperature and stabilize. This is very important at faster ramp rates. 
The value needed will depend on the ramp rate, furnace, specimen holder, etc.

The data interval is set at 5 seconds to capture as much data as possible for a 
more accurate file.

Log Data is set to on or else no data will be collected.

Once all the values are correctly set, select the Okay button to save the current 
segment. Then select the Save As button to save this temperature program as 
"ramp01.set" and make sure it is the selected program for the experiment setup!

Note: Since there is usually no valid data for viscometers until a high 
temperature is reached, a heating segment can be used to raise the temperature 
of the instrument before the above segment that collects the data. Simply follow 
the procedure for creating a cooling correction file but heat the instrument further 
instead of cooling it.

Note: For temperature correction files that run from a high temperature to a low 
temperature (cooling): The instrument can be heated to the high temperature 
using a first segment that does not log data. The second segment would then 
cool the instrument at the desired ramp rate and does log data. This temperature 
correction file will be built using only the cooling data. A temperature correction 
file can not be created by a temperature program that has both heating and 
cooling segments that log data!
Important: See the note at the end of this document for more information about 
cooling data temperature correction files!

Main Experiment setup:

Enter the Main tab and select the Change button to set up the experiment as 
follows:



Select the temperature program that was just created, "ramp01.set".

Select a new data filename as "ramp01.prn". This MUST be correctly set 
according to the ramp rate! The file names are created as starting with the word 
"ramp", followed by the actual ramp rate as "01", followed by the standard ".prn" 
file extension. The ramp rate must be two numbers with rates of 1 to 9 preceded 
by a zero (0). Rates above 9 (10, 11, 12, etc.) are NOT preceded by a zero (e.g.. 
"ramp13.prn"). Only integer values are allowed, therefore a ramp rate of 2.5 is 
not valid!

Select the known material for the specimen.

Enter the exact measurements of the specimen material. The selected 
height/width/diameter of the specimen material should be as close as possible to 
those of future experiment specimen samples. The closer these parameters 
match, the more accurate the temperature correction file will be in the 
experiments.

Make sure that "Use correction file" is NOT checked!
Make sure that "Use temperature correction file" is NOT checked!



Select the Save As button to save this experiment, here as "test.exp". For future 
reference, names describing the ramp rates could be used such as 
"ramp01.exp".

Now that all the data has been entered and the temperature program set and 
selected, the experiment can be started.

Allow the experiment to run through to the end. Once completed, the 
temperature correction file for the selected ramp rate is created and can be used 
in future experiments by simply checking the box labeled Use temperature 
correction file.

Using the temperature correction files:

When setting up a new experiment, simply check the Use temperature correction 
file box in the experiment setup screen. The files matching the ramp rate in the 
current segment of the temperature program will automatically be used as the 
experiment is run. All collected and calculated data is processed with the 
temperature correction file. However, for reference purposes, the uncorrected 
absolute values are also saved.

Most experiments are run using more than one ramp rate in multiple segments of 
the temperature program. DilaSoft for Windows will try to match the current ramp 
rate with a temperature correction file. If a corresponding temperature correction 
file is found, those values will be used. If not, no correction is made and the 
experiment continues. Therefore, temperature correction files must be named 
"rampxx.prn" where the "xx" corresponds to the integer value of the current ramp 
rate.

If temperature correction files are made from cooling data, make sure they are 
not used with heating temperature programs! The temperature correction files 
will work with either heating or cooling segments, however the data will only be 
accurate for the same type of segment that was used to create the temperature 
correction file.

Materials Note:  Normally the specimen material is a known type to calibrate and 
create the temperature correction files. However, the specimen material could be 
chosen as a user created type (select "unknown") to produce data and 
temperature correction files that will compare the difference of new materials to a 
selected "standard" material. Using a temperature correction file created with the 



"unknown" specimen would produce a data file with zero differential when run 
with that same specimen.  This may be useful to companies that produce 
materials and want to see the differences in production runs.

Special Note about Cooling Data temperature correction files:

Although temperature correction files can be created and used for cooling 
cycles, special consideration must be given to their creation and use. If a 
temperature correction file is created as specified above, it can only be used for 
an experiment that follows the exact same temperature program settings. For 
example:

A standard cooling temperature correction file is created using a two line 
temperature program as follows:

1: Ramp at 1 degree to 1000 degrees and hold for 5 minutes, do not log data.
2: Ramp at 1 degree to 20 degrees and hold for 5 minutes, log data.

The resulting temperature correction file will be valid for use only when using the 
exact same format in the temperature program as for the experiment! Data 
logging can not take place before the instrument reaches 1000 degrees.

The reason for this is that the software will calculate zero expansion at the first 
segment that logs data. In this example, no data is logged in the first segment. 
When the second segment is reached at 1000 degrees, zero expansion is 
calculated and used as the reference point to the end of the experiment. So the 
temperature correction file created from this temperature program will have a 
zero correction factor at 1000 degrees and will not be valid if data is logged 
during the experiment before 1000 degrees and it being a cooling cycle.

Creating temperature correction files for heating/cooling experiments:

If the user wishes to use temperature correction files in both heating and cooling 
cycles in the same experiment, the following procedure must be followed: Also 
see the next section!

First, the temperature correction file must be created for this type of experiment 
and must have zero expansion at the end of the cooling cycle instead of the 
beginning. To accomplish this, the following example temperature program must 
be used:



1: Ramp 0 degrees to 20 degrees and hold for 0 minutes, log data.
2: Ramp 1 degree to 1000 degrees and hold for 5 minutes, NO log data.
3: Ramp 1 degree to 20 degrees and hold for 5 minutes, Log data.

In this example, the 20 degrees is an arbitrary 'room temperature' and can be 
changed. The first segment must log data to disable the software's feature of 
zeroing the expansion at 1000 degrees when the first data logging segment is 
reached. Only a single data point must be logged. The second segment heats up 
the instrument to the desired temperature and does not log data as this would be 
heating data and not wanted. The third segment cools from 1000 degrees down 
to 20 degrees and logs data to create the cooling temperature correction file 
data.

A sample experiment temperature program would look like:

1: Ramp at 4 degrees to 1000 degrees and hold for 5 minutes, log data.
2: Ramp at 3 degrees to 20 degrees and hold for 5 minutes, log data.

This example is for the actual experiment. The corresponding temperature 
correction files for heating at 4 degrees per minute and cooling at 3 degrees per 
minute would have been previously created.

Another method to create heating/cooling temperature correction files:

Since the change to the new filenames (see note below), temperature correction 
files using the same ramp rate are now allowed. There is another method to 
create heating/cooling files. Use a temperature program that heats the specimen 
at the specified ramp rate and then cools at the same rate. For example:

1: Ramp at 4 degrees to 1000 degrees and hold for 5 minutes, log data.
2: Ramp at 4 degrees to 20 degrees and hold for 5 minutes, log data.

This will create a data file that contains both the heating and cooling ramps. Now 
load this stored data file into the analyze program. The entire data set will be 
seen. Scroll down to the point where the temperature reaches 1000 degrees and 
highlight the next line. Do this by clicking the row number on the left side of the 
worksheet, the entire row will be highlighted. Scroll down to the last row. Hold 
down the SHIFT key and click on the last row number. The entire section should 
now be highlighted. Now hold down the Ctrl (control) key and hit the DEL or 
Delete key. The entire highlighted section should be deleted. If the contents of 
the selected range is deleted but the rows still exist, you didn't hold down the 
Ctrl key! You can also go to the Edit menu and select Delete from there. What is 



left is the heating section of the data file. Go to the File menu and select Save 
As. Save this file as ramp04h.prn. The ramp rate was 4 degrees per minute and 
it is a heating file.

Now load the original file back into analyze. This time select the second line of 
the worksheet by clicking on the row number (row 2). Now scroll down to where 
the temperature starts to decrease. Find the row that has the highest 
temperature, then one row above that. Select that row by holding down the 
SHIFT key and clicking on the row number with the mouse. The entire heating 
section of the worksheet should now be highlighted. Again, hold down the Ctrl 
(Control) key and hit the Delete key. The entire heating section of the worksheet 
should now be deleted. Again go to the File menu and select Save As. This time 
name the file ramp04c.prn. The ramp rate was still 4 degrees per minute, but this 
is a cooling file.

This procedure has created two temperature correction files out of a single 
experiment file. One for heating and one for cooling, both with the same ramp 
rate.

When using this procedure, make sure of the temperature ranges before 
deleting sections. If a mistake is made, the original file can be reloaded to start 
again. Also make sure that the original file is not named the same as the final 
temperature correction file or it will be overwritten when the temperature 
correction file is saved and will not be able to be reloaded.

The reason the second row is selected above for the cooling file is due to a 
problem in the worksheet program. It does not allow for the first row to be 
deleted for any reason. If the first row is selected, nothing will be deleted. Make 
sure to start the selection on the second row! This will not affect the temperature 
correction file as the software discards the first row of data since this is normally 
all zeroes and not true data.

Using temperature correction files for heating and cooling with the same ramp 
rate.

A change has been made to the temperature correction file handling. Filenames 
are now supported using the letters "h" and "c" appended to the temperature 
correction filename. These correspond to "h"=heating and "c"=cooling. For 
example: A temperature correction file that ramps at 4 degrees per minute and is 
heating would normally be named: ramp04.prn. The new filename to designate a 
heating temperature correction file would be: ramp04h.prn. This change allows 
heating and cooling temperature correction files to be used with the same ramp 



rate. So the cooling temperature correction file for the above example would be: 
ramp04c.prn.

Temperature correction filenames using the original format do not have to be 
renamed. The software will look first for a temperature correction file named to 
the new format. If non are found, it will search for a temperature correction file in 
the old format. If both heating and cooling temperature correction files are to be 
used with the same ramp rate, the new format is required!

Contacting Theta Industries, Inc.

If any clarification or further information is needed, feel free to contact Theta 
Industries, Inc. by any of the following means:

For instrument specific or general information:
Web site:  http://www.theta-us.com
e-mail:  theta@theta-us.com

For DilaSoft I for Windows only support or information:
e-mail: rich@bearlycomputing.com


